MICROSOFT* OFFICE

Excel 2007

Excel Tutorial 3

Working with Formulas
and Functions

NEW PERSPECTIVES
COMPREHENSIVE




Objectives

* Copy formulas

* Build formulas containing relative, absolute, and
mixed references

* Review function syntax

* |[nsert a function with the Insert Function dialog
00X

e Search for a function

* Type a function directly in a cell
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Objectives

e Use AutofFill to fill in a formula and complete a
series

* Enter the IF logical function
* |nsert the date with the TODAY function

* Calculate monthly mortgage payments with the
PMT financial function
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Using Relative References

Figure 3-2 Formula using a relative reference

A
1 10 120 30
original formula 5
with a relative
reference 3 [-A1 !
4
5
formula copied A ;
ormula copie
to a new range 10 [20 ]30
(coumnandrow 2
references shift 3 }=A1 {=B1 =C1 |
based on cell 5 B
location)
5
B A |
10 20 30
formula results el
. 10} 20 30|

New Perspectives on Microsoft Office Excel 2007




Using Absolute References

Formula using an absolute reference Figure 3-3
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Using Mixed References

Formulas using mixed references Figure 3-5
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Entering Relative, Absolute, and Mixed
References

* To enter a relative reference, type the cell reference as it appears
in the worksheet. For example, enter B2 for cell B2

* To enter an absolute reference, type S (a dollar sign) before both
the row and column references. For example, enter SBS2

* To enter a mixed reference, type S before either the row or
column reference. For example, enter SB2 or BS2

or
e Select the cell reference you want to change

* Press the F4 key to cycle the reference from relative to absolute
to mixed and then back to relative
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Understanding Function Syntax

e Every function has to follow a set of rules, or
syntax, which specifies how the function should
be written

— Arguments
Categories of Excel functions

Category Contains functions that

Cube Retrieve data from multidimensional databases involving online analytical processing
or OLAP

Database Retrieve and analyze data stored in databases

Date & Time Analyze or create date and time values and time intervals

Engineering Analyze engineering problems

Financial Have financial applications

Information Return information about the format, location, or contents of worksheet cells

Logical Return logical (true-false) values

Lookup & Look up and return data matching a set of specified conditions from a range

Reference

Math & Trig Have math and trigonometry applications

Statistical Provide statistical analyses of a set of data

Text Return text values or evaluate text
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Understanding Function Syntax

Math, Trig, and Statistical functions

Function

Category

AVERAGE(numberT [, number2, Statistical
number3, ...])

Description

Calculates the average of a collection of numbers, where number1, number2, and so
forth are either numbers or cell references. Only numberT is required. For more than
one cell reference or to enter numbers directly into the function, use the optional
arguments number2, number3, and so forth.

COUNT(valueT [, value2, Statistical Counts how many cells in a range contain numbers, where value7, value2, and so forth

value3s, ...)) are text, numbers, or cell references. Only valueT is required. For more than one cell ref-
erence or to enter numbers directly into the function, use the optional arguments value2,
value3, and so forth.

COUNTA(valuel, [,value2, Statistical Counts how many cells are not empty in ranges valueT, value2, and so forth, or how

value3, ...] many numbers are listed within value, value2, and so forth.

INT(number) Math & Trig  Displays the integer portion of a number, number.

MAX(numberl [, number2, Statistical Calculates the maximum value of a collection of numbers, where numberT,

number3, ...)) number2, and so forth are either numbers or cell references.

MEDIAN(number [, number2, Statistical Calculates the median, or middle, value of a collection of numbers, where

numbers3, ...)) numberl, number2, and so forth are either numbers or cell references.

MIN(numberT [, number2, Statistical Calculates the minimum value of a collection of numbers, where number1,

numbers3, ...)) number2, and so forth are either numbers or cell references.

RAND() Math & Trig  Returns a random number between 0 and 1.

ROUND(number, num_digits) Math & Trig  Rounds a number to a specified number of digits, where number is the number you want
to round and num_digits specifies how many digits to which you want to round the
number.

SUM(numberT [, number2, Math & Trig  Adds a collection of numbers, where number1, number2, and so forth are either num-

numbers3, ...)

bers or cell references.
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Inserting a Function

 Click the Formulas tab on the Ribbon

* To insert a function from a specific category, click the
appropriate category button in the Function Library
group. To search for a function, click the Insert Function
button in the Function Library group, enter a description
of the function, and then click the Go button

* Select the appropriate function from the list of functions

‘J -

* Enter the argument values in the Function Arguments
dialog box, and then click the OK button
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Inserting a Function

Figure 3-8 Function Arguments dialog box
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YC_’U can click the Collapse required 3= Numberl |D21:021 - [2950,2950,2950,2950,2950, 3800, ...
Dialog Box button to argument Murbe2 | = number
shrink the Function Argu- T
ments dialog box to see optional | preview of the value
more of the worksheet, argument returned by the function
select the range, and then with the current
click the Expand Dialog - 3,!50 argument values
Box button to restore the Adds al the rumbers in a rang= of cels,
didog box Numberl: numberlnumber2,... are 1to 255 numbers to sum. Logical values and text
description Of are ignared In cells, nduded if typed as arguments,
the function text that will + description of the
Formiaresit = 37,950 —s—{ be displayed in Number1 argument
foevn the worksheet o ) [ o |

11

New Perspectives on Microsoft Office Excel 2007




Inserting a Function

Figure 3-10 Insert Function dialog box
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ames, arrays, or references that contain numbers,
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Typing a Function

* As you begin to type a function name within a
formula, a list of functions that begin with the
letters you typed appears

Figure 3-12 Typing a function
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Working with AutofFill

e AutoFill copies content and formats from a cell or range into an
adjacent cell or range

* Select the cell or range that contains the formula or formulas you
want to copy

* Drag the fill handle in the direction you want to copy the
formula(s) and then release the mouse button

 To copy only the formats or only the formulas, click the AutofFill
Options button and select the appropriate option

* Select the cell or range that contains the formula or formulas you
want to copy

* Inthe Editing group on the Home tab, click the Fill button

* Select the appropriate fill direction and fill type (or click Series,
enter the desired fill series options, and then click the OK button)
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orking with Autofill

Formulas and formats copied with AutoFill Figure 3-17

19 2,500 2,500 2,500 2,500 2,500 2,500 2,500 2,500 2,500 2,500
20 950 950 950 1,800 1,800 1,800 950 950 950 950
21 3,450 3,450 3,450 4,300 4,300 4,300 3,450 3,450 3,450 3,450
22 850 850 850 850 850 850 850 850 850 850
23 650 650 650 650 650 650 650 650 650 650
24 175 165 120 135 145 145 140 140 170 210
25 75 75 75 75 75 75 75 75 75 75
26 175 175 175 175 175 175 175 175 175 175
27 125 125 125 125 125 125 125 125 125 125 3
28 0 0 0 900 0 1,900 0 0 0 0
29 0 0 0 300 0 700 0 0 0 0 -
30 150 450 120 180 720 400 130 150 250 300 A“t?F'“
31 150 150 150 150 150 150 150 150 150 150/ | Options
32 2,350 2,640 2,265 3,540 2,890 5,170 2,295 2,315 2,445 2,535 | button
33
34 ™
35
36 formula and formats copied
e odto the selected range :
Ready 7 |
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Using the AutoFill Options Button

e By default, AutoFill copies both the formulas and

the formats of the original range to the selected
range

* You can specify what is copied by using the

AutoFill Options button that appears after you
release the mouse button

AutoFill options Figure 3-18

copies the cells, filling in
both formats and formulas

[ copies only the formats |0 il formatting only
O Fill withgut Formatting <€—{ copies only the formulas |
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Filling a Series

e AutoFill can also be used to create a series of
numbers, dates, or text based on a pattern

Figure 3-19 AutoFill extends a numeric sequence

Anl B

1 1 initial range 1 1
2 2 }4— establishes the 2 2
3 el series pattern 3 3
4 A 4 4|
5 5 5
6 | 6 6 dragging the fill handle
7 M 7 7| ¢t~ extends the pattern to
8 | 8 8 a larger range
9 9 9
10 10 10
1 1 =
2 12
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Filling a Series

Figure 3-20 AutoFill applied to different series

Type Initial Entry Extended Series
Values 1,23 4,5,6, ..
2,4,6 8,10, 12, ...
Dates and Times Jan Feb, Mar, Apr, ...
January February, March, April, ...
15-Jan, 15-Feb 15-Mar, 15-Apr, 15-May, ...
12/30/2010 12/31/2010, 1/1/2011, 1/2/2011, ...

12/31/2010, 1/31/2011

2/28/2011, 3/31/2011, 4/30/2011, ...

Mon

Tue, Wed, Thu, ...

Monday Tuesday, Wednesday, Thursday, ...
11:00AM 12:00PM, 1:00PM, 2:00PM, ...

Patterned Text 1st period 2nd period, 3rd period, 4th period, ...
Region 1 Region 2, Region 3, Region 4, ...
Quarter 3 Quarter 4, Quarter 1, Quarter 2, ...
Qtr3 Qtr4, Qtr1, Qtr2, ...
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Creating a Series with AutoFill

* Enter the first few values of the series into a range

e Select the range, and then drag the fill handle of the
selected range over the cells you want to fill

or
* Enter the first few values of the series into a range

* Select the entire range into which you want to extend
the series

* In the Editing group on the Home tab, click the Fill
button, and then click Down, Right, Up, Left, Series, or
Justify to set the direction you want to extend the series
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Working with Logical Functions

* Alogical function is a function that works with
values that are either true or false

* The IF function is a logical function that returns
one value if the statement is true and returns a
different value if the statement is false

* |F(logical test, value if true, [value if false])
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Working with Logical Functions

* A comparison operator is a symbol that indicates
the relationship between two values

Comparison operators Figure 3-27

Operator Statement Tests whether

= A1=B1 the value in cell A1 is equal to the value in cell B1

> A1>B1 the value in cell A1 is greater than the value in cell B1

< A1 <B1 the value in cell A1 is less than the value in cell B1

>= A1 >=B1 the value in cell Al is greater than or equal to the value in cell B1
<= A1l <=BI the value in cell A1 is less than or equal to the value in cell B1
<> A1 <>B1 the value in cell Al is not equal to the value in cell B1

21
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Working with Logical Functions

+ =IF(A1="YES", "DONE", "RESTART")

e =IF(A1="MAXIMUM", MAX(B1:B10),
MIN(B1:B10))

- =IF(D33>0, $K$10, 0)
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Working with Logical Functions

Function arguments for the IF function Figure 3-28

test condition that is
either true or false

value returned if the
condition is true

value returned if the
condition is false
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Working with Date Functions

Date functions Figure 3-31

Function Description

DATE(year, month, day) Creates a date value for the date represented by the year,
month, and day arguments

DAY(date) Extracts the day of the month from the date value

MONTH(date) Extracts the month number from the date value where 1=January,
2=February, and so forth

YEAR(date) Extracts the year number from the date value

WEEKDAY(date, [return_type]) Calculates the day of the week from the date value, where

1=Sunday, 2=Monday, and so forth; to choose a different number-
ing scheme, set the optional return_type value to “1” (1=Sunday,
2=Monday, ...), “2" (1=Monday, 2=Tuesday, ...), or “3"” (0=Monday,

1=Tuesday, ...)
NOW() Displays the current date and time
TODAY() Displays the current date

New Perspectives on Microsoft Office Excel 2007 24




Working with Financial Functions

Figure 3-33 Financial functions for loans and investments

Function Description

FV(rate, nper, pmt, [pv=0] [,type=0]) Returns the future value of an investment, where rate is the
interest rate per period, nper is the total number of periods,
pmt is the payment in each period, pv is the present value of
the investment, and type indicates whether payments should
be made at the end of the period (0) or the beginning of the
period (1)

PMT(rate, nper, pv, [fv=0],type=0]) Calculates the payments required each period on a loan or
investment

IPMT(rate, per, nper, pv, [fv=0][,type=0]) Calculates the amount of a loan payment devoted to paying
the loan interest, where per is the number of the payment
period

PPMT(rate, per, nper, pv, [fv=0][,type=0]) Calculates the amount of a loan payment devoted to paying
off the principal of a loan, where per is the number of the
payment period

PV(rate, nper, pmt, [fv=0][,type=0]) Calculates the present value of a loan or investment based on
periodic, constant payments

NPER(rate, pmt, pv, [fv=0][,type=0]) Calculates the number of periods required to pay off a loan
or investment

RATE(nper, pmt, pv, [fv=0][,type=0]) Calculates the interest rate of a loan or investment based on
periodic, constant payments
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Using the PMT Function to Determine
a Monthly Loan Payment

* For loan or investment calculations, you need to
know the following information:

— The annual interest rate

— The payment period, or how often payments are due
and interest is compounded

— The length of the loan in terms of the number of
payment periods

— The amount being borrowed or invested

 PMT(rate, nper, pv, [fv=0] [type=0])
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Using the PMT Function to Determine
a Monthly Loan Payment

Function Arguments dialog box for the PMT function Figure 3-35

' Function Arguments R 5|
PMT
Rate g5 [@] - o.c0s416657
Nper &7 ) @ = 240
Pv &8 ] = 1s0000
Fv @ = number
Type @ = number

= -1192.917017
Calcuates the payment for a loan based an constant payments and a constant interest rate,

Fv I3 the future value, or a cash balance you want to attan after the last
payment & made, O (2ero) If omitted,

Formua result = -1192.917017

Help 00 this Anction [ ox ][ caa |
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Using the PMT Function to Determine
a Monthly Loan Payment

Monthly payment for a $160,000 loan

(6,, H9-> v Drake Family Budget - Microsoft Excel - X
Home Insert Page Layout Formulas Data Review  View ®-°Xx
b . = | e - ) ) || g=lnsert> || X -
e[ (S ] | e K owom o s b
e | @2 0[] O A [ (5%l )| Contmont o con | oy | Sote fnas
Clipboard = Font i Alignment o Styles Cells Editing
89 <~ S| =-PMT(85,87, 88) <] PMT f":;‘fmon“ BO [z
& B ‘ entered in ce! E . G H | i
1 Home Loan
2
3 Annual Interest Rate 6.50%
4 Interest Payments per Year 12
5 |Interest Rate per Period 0.0054167
6 Number of Years 20
7 Number of Payments 240
8 Loan Amount 160,000 BN e ] by
9 |Monthly Loan Payment $1,192.92 |- 5 1
10 the PMT function
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